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Introduction
This manual describes the printer and scanner functions of the AL-1633/1644 digital multifunctional system.

Trademark Acknowledgments
�Microsoft® Windows® operating system is a trademark or copyright of Microsoft Corporation in the U.S.A. and other countries.
�Windows® 95, Windows® 98, Windows® Me, Windows NT® 4.0, Windows® 2000, and Windows® XP are trademarks or copyrights 
of Microsoft Corporation in the U.S.A. and other countries.

�Acrobat® Reader Copyright© 1987- 2002 Adobe Systems Incorporated. All rights reserved. Adobe, the Adobe logo, Acrobat, and 
the Acrobat logo are trademarks of Adobe Systems Incorporated.

�All other trademarks and copyrights are the property of their respective owners.

� For information on the following topics, please refer to the Operation Manual for the digital multifunctional system.
•Basic machine procedures (adding paper, replacing the TD cartridge, removing misfeeds, using peripheral devices)
•Copier functions
•Scanning from the operation panel of the machine
•Resolving printer and scanner problems
•Specifications

� Where "AL-XXXX" appears in this manual, please substitute the name of your model for "XXXX". For the name of your model, see 
"DIFFERENCES BETWEEN MODELS" in the Operation Manual.

� This manual refers to the Single pass feeder as the "SPF".
� The screen images and procedures that appear in this manual are mainly for Windows XP. With other versions of Windows, some 

screen images may be different from those in this manual.
� For information on using your operating system, refer to your operating system's manual or online Help.

Note
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How to Use the Online Manual
This section explains how to view the online manual. Please read this section before using the online manual.
For information on using Acrobat Reader, see Acrobat Reader Help.

How to Control the Online Manual
In this manual, the following buttons are displayed at the 
bottom of each page. Click these buttons to move quickly to 
pages that you wish to view.

Displays the Contents of this manual. Click on a topic in the 
Contents to jump directly to that section.

Displays the Index of this manual. Click on a topic in the Index 
to jump directly to that section.

Takes you forward page by page.

Takes you back page by page.

Following Links
This manual uses a link function that allows you to jump to a 
related page. If you click green, underlined text, the related 
page will be displayed. (In the Contents and Index sections, the 
linked areas are not underlined.)
Example: ☞Contents
To return to the previous page, click the  button on the menu 
bar of Acrobat Reader.

Using Bookmarks
Bookmarks have been created on the left side of this manual. 
You can click on a bookmark to jump directly to that section.

How to Print Out This Manual
To print this manual, select "Print" from the "File" menu of 
Acrobat Reader. Select the desired printer settings in the "Print" 
dialog box, and then click the "OK" button.

CONTENTS

I N D E X
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Basic Printing (part 1)
The following example explains how to print a document on A4 size paper from WordPad.
Before printing, make sure that the correct size of paper for your document has been loaded in the machine.

1 Make sure that the ON LINE indicator on the 
operation panel is lit.
If the ON LINE indicator is not lit, press the [ON LINE] 
key ( ).

When the indicator is:
●Lit, the machine is online and 
ready to print, or is printing.

● Blinking, the machine is 
processing print data in memory 
or printing has been paused.

●Off, the machine is off-line 
and cannot print.

2 Start WordPad and open the document that you 
wish to print.

3 Select "Print" from the application's "File" 
menu.
The "Print" dialog box will appear.

4 Make sure that "SHARP AL-XXXX" is selected as 
the printer. If you need to change any print 
settings, click the "Preferences" button 
("Properties" button in Windows 95/98/Me/NT 4.0) 
to open the printer driver setup screen.
The printer driver setup screen will appear.

Windows 2000 does not have the "Preferences" button 
in this dialog box. Select settings as needed on each of 
the tabs in the setup screen.
☞Printer Driver Settings, Printing Multiple Pages on One Page, 

Fitting the Printed Image to the Paper,
Rotating the Print Image 180 Degrees, Printing a Watermark

5 Click the "Print" button ("OK" button in 
Windows 95/98/Me/NT 4.0).
Printing begins. When printing begins, the Print Status 
Window automatically opens.
(☞Outline of the Print Status Window)

The print job is delivered to the output tray, with the position of 
the paper offset slightly from the previous job (offset function).
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Basic Printing (part 2)

If the tray runs out of paper during printing
Add paper to the tray or press the [TRAY SELECT] key ( ) to 
select a different tray, and then press the [ON LINE] key ( ) to 
resume printing.
Note that if "Auto tray switching" (in the user programs) is 
enabled on a 2-tray model and "Auto Select" is selected in 
"Paper Source" in the printer driver, the machine will 
automatically switch to the other tray and continue printing.

Pausing a print job
To pause a print job during printing, press the [ON LINE] key 
( ) on the operation panel to switch the machine off-line. 
Printing will be paused and the ON LINE indicator will blink.
� To cancel a print job, press the [CLEAR] key ( ) or the 

[CLEAR ALL] key ( ).
� To resume printing, press the [ON LINE] key ( ) to switch the 

machine online.

When "Paper Source" is set to "Auto Select"
If "Paper Source" is set to "Auto Select" in the "Paper" tab of the 
printer driver setup screen and the correct size of paper for a 
print job is not loaded in the machine, the printing procedure will 
vary depending on the "Use Close Paper Size" setting in the user 
programs (see "USER PROGRAMS" in the Operation Manual).

When "Use close paper size" is disabled
The PAPER SIZE indicator on the 
operation panel will blink. You can press 
the [TRAY SELECT] key ( ) to select a 
tray manually, or load paper in the 
bypass tray and press the [ON LINE] 
key ( ) to begin printing.
* The paper sizes that appear in the 

operation panel will vary by country and region.

When "Use close paper size" is enabled
Printing will take place using a size of paper that is close to the 
size of the print image.

Before printing make sure that the paper size set in "Set 
Tray Status" of the printer driver is the same as the size 
of paper loaded in the tray. (See "CONFIGURING THE 
PRINTER DRIVER" in the Software Setup Guide.)
When printing, if you select the paper tray with the correct 
size of paper for the document to be printed, printing will 
take place correctly (select the paper tray in "Paper source" 
in the "Paper" tab of the printer driver setup screen).

A3
A4
A4
A5
B4

EXTRA

Note
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Opening the Printer Driver From the "Start" Button
You can open the printer driver and change the printer driver settings from the Windows "start" button. Settings adjusted in this way 
will be the initial settings when you print from an application. (If you change the settings from the printer driver setup screen at the 
time of printing, the settings will revert to the initial settings when you quit the application.)

Windows 2000/XP

1 Click the "start" button, and then click "Control 
Panel".
In Windows 2000, click the "Start" button and select "Settings".

2 Click "Printers and Other Hardware", and then 
click "Printers and Faxes".
In Windows 2000, click "Printers".

3 Click the "SHARP AL-XXXX" printer driver icon 
and select "Properties" from the "File" menu.

4 Click the "Printing Preferences" button in the 
"General" tab.
The printer driver setup screen will appear.
☞Printer Driver Settings

Windows 95/98/Me/NT 4.0

1 Click the "Start" button, select "Settings" and 
then click "Printers".

2 Click the "SHARP AL-XXXX" printer driver icon 
and select "Properties" from the "File" menu.

3 In Windows 95/98/Me, click the "Setup" tab.

The printer driver setup screen will appear.
☞Printer Driver Settings

In Windows NT 4.0, select "Document Defaults" to open 
the printer driver setup screen.

Note
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Printer Driver Settings
To view Help for a setting, click the  button in the upper right-hand corner of the window and then click the setting.
Some restrictions exist on the combinations of settings that can be selected in the printer driver setup screen. When a restriction is 
in effect, an information icon ( ) will appear next to the setting. Click the icon to view an explanation of the restriction.

Tab
The settings are grouped 
on tabs. Click on a tab to 
bring it to the front.
Checkbox
Click on a checkbox to 
activate or deactivate a 
function.
Print setting image
This shows the effect of the 
selected print settings.
Drop-down list
Allows you to make a selection 
from a list of choices.
Image of paper trays
The tray selected in "Paper 
Selection" in the "Paper" tab 
appears in blue. You can also 
click on a tray to select it.

"OK" button
Click this button to save 
your settings and exit the 
dialog box.
"Cancel" button
Click this button to exit the 
dialog box without making any 
changes to the settings.
"Apply" button
Click to save your settings 
without closing the dialog box.

"Help" button
Click this button to display the 
help file for the printer driver.

1

3

2

4

5

6
7
8

9

The settings and the image of the machine will vary 
depending on the model.Note

1

2

3

4

5

Windows NT 4.0 
does not have the 
"Apply" button.
The "Apply" button 
does not appear when 
you open this window 
from an application.

6

7

8

Note

9



1 PRINT

9CONTENTS I N D E X

Printing Multiple Pages on One Page
This feature allows you to reduce and print two or four document pages on a single sheet of paper.
To use this function, open the printer driver setup screen and select "2-Up" or "4-Up" for "N-Up Printing" on the "Main" tab.
☞See Basic Printing for details on how to open the printer driver.

If you select the "Border" checkbox, borderlines will be printed around each page.

The "N-Up Printing" setting is not available when "Fit To Paper Size" is selected.
☞Fitting the Printed Image to the Paper

N-Up Border Border

"2-Up"

"4-Up"

Note
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Fitting the Printed Image to the Paper
The printer driver can adjust the size of the printed image to match the size of the paper loaded in the machine.
Follow the steps shown below to use this function. The explanation below assumes that you intend to print an A3 size document on 
A4 size paper.
☞See Basic Printing for details on how to open the printer driver.

1 Click the "Paper" tab in the printer driver setup 
screen.

2 Select the original size (A3) of the print image in 
"Paper Size".

3 Check the "Fit To Page" box.

4 Select the actual size of paper to be used for 
printing (A4).
The size of the printed image will be automatically 
adjusted to match the paper loaded in the machine.

The "Fit To Paper Size" setting is not available when "N-Up Printing" is selected.
☞Printing Multiple Pages on One Page

Note

Paper Size: A3
Fit To Paper Size: A4

A3 size document
(Paper Size)

A4 size paper 
(Fit To Paper Size)
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Rotating the Print Image 180 Degrees
The print image can be rotated 180 degrees.
This feature is used to enable correct printing on envelopes and other paper with flaps that can 
only be loaded in one orientation.
To use the feature, select the image orientation in "Image Orientation" on the "Paper" tab, and 
then select the "Rotate 180 degrees" checkbox. 
�See Basic Printing for details on how to open the printer driver.

The following example shows correct and incorrect rotation of an address printed on an envelope.

Printing result

Landscape
Rotate 180 degrees

Landscape
Rotate 180 degrees

The procedure for loading paper is explained in the Operation Manual.

ABCD

ABCD

Note
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Printing a Watermark
You can print a watermark such as "CONFIDENTIAL" on your document. To print a watermark, open the printer driver, click the 
"Watermarks" tab, and follow the steps below.
☞See Basic Printing for details on how to open the printer driver.

How to Print a Watermark
From the "Watermark" drop-down list, select the watermark that you wish to print (for example "CONFIDENTIAL"), and start printing.

You can enter text to create your own custom watermark. For details on watermark settings, view printer driver Help.
☞Printer Driver Settings

Print sample
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Outline of the Print Status Window
When printing begins, the Print Status Window automatically opens.
The Print Status Window is a utility that monitors the machine and shows the name of the document being printed and any error 
messages that occur.

Status window
Provides information on the 
current status of the printer.
Status icon
The status icons appear to 
alert you to printer errors. 
Nothing appears when 
printing is taking place 
normally.
The icons are explained 
below. Follow the 
instructions in the status 
window to solve the 
problem.

Tab
Click a tab to bring it to the 
front. The "Options" tab 
allows you to select display 
options for the Print Status 
Window.
Document Name
Shows the name of the 
document currently being 
printed.
"Cancel Job" button
Click this button during 
printing to cancel the job 
that is currently being 
executed.
"Help" button
Click this button to display 
the help file for the Print 
Status Window.
"Close" button
Click this button to close 
the Print Status Window.

1

2

3

4

5

6

7

Icon Print Status
An error has 
occurred that 
requires immediate 
attention.

An error has 
occurred that 
requires attention 
soon.

1

2

3

4

5

6

7
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Sharing the Printer Using Windows Networking
The machine can be used as a shared printer in a Windows 95/98/Me/NT 4.0/2000/XP network environment.
Note that the Windows network environment must already be established.

"Print server" as explained here is a computer that is directly connected to the machine, and a "Client" is any other computer that is 
connected to the same network.

Shared printer
Client

Client Client

Print server

☞Shared Printer Settings
(On the print server) ☞Client Settings
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Shared Printer Settings
On the computer to which the machine is directly connected
Follow the steps below to use the computer directly connected to the machine as a print server.
If your operating system is Windows 95/98/Me, start from step 1. If your operating system is Windows NT 4.0, 2000 or XP Home 
Edition, open the control panel and then start from step 6.

1 Click the "Start" button, select "Settings", and 
then click "Control Panel".

2 Double-click the "Network" icon ( ).

3 Click the "File and Print Sharing" button.

4 Enable "I want to be able to allow others to print 
to my printer(s)." by clicking the checkbox, and 
then click the "OK" button.

5 Click the "OK" button in the "Network" dialog 
box.

6 Click "Printers and Other Hardware" in the 
control panel, and click "Printers and Faxes".
In operating systems other than Windows XP, 
double-click the printer icon.

7 Click the "SHARP AL-XXXX" printer driver icon 
and select "Sharing" from the "File" menu.

8 Establish the settings for sharing, and click the 
"OK" button.

☞Client Settings

If your operating system is Windows XP Professional, refer to the Operation Manual or the help file of your operating system.Note

If the "Network" icon does not appear in Windows Me, 
click "view all Control Panel options".

Note

If a message appears asking you to restart the 
computer, click the "Yes" button and restart the 
computer. Then, open the printer folder and continue the 
setup procedures from Step 6.

For information on a setting, click the  button at the 
top-right of the dialog box and then click the setting to 
display Help.

Note

Note
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Client Settings (part 1)
Follow the procedure below to install the printer driver in the client.

1 Click the "start" button, and click "Control 
Panel".

2 Click "Printers and Other Hardware", and click 
"Printers and Faxes".

3 Click "Add a printer" in "Printer Tasks".
The "Add Printer Wizard" will appear.

4 Click the "Next" button.

This page provides steps for Windows XP Home Edition users only. If your operating system is Windows 95/98/Me/2000/XP 
Professional, refer to the Operation Manual or the help file of your operating system.
If your operating system is Windows NT 4.0, refer to "Settings in Windows NT 4.0".

Note
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Client Settings (part 2)

5 Select "A network printer, or a printer attached 
to another computer", and click the "Next" 
button.

6 Select "Browse for a printer", and click the 
"Next" button.

7 Select the printer to be shared in the network, 
and click the "Next" button.

The contents of this window will vary depending on your 
network environment.

8 Select settings in the "Default Printer" screen, 
and click the "Next" button.

9 Click the "Finish" button.
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Client Settings (part 3)

Settings in Windows NT 4.0
If your operating system is Windows NT 4.0, establish settings as follows in the printer properties after installing the printer driver.
For the procedure for installing the printer driver, see "INSTALLING THE SOFTWARE" in the Software Setup Guide.

1 Click the "Start" button, select "Settings", and 
then click "Printers".

2 Click the "SHARP AL-XXXX" printer driver icon 
and select "Properties" from the "File" menu.
The printer properties will appear.

3 Click the "Ports" tab, and click the "Add Port"
button.
The "Printer Ports" dialog box will appear.

4 Select "Local Port" in the "Available Printer 
Ports" list, and click the "New Port" button.
The "Port Name" dialog box will appear.

5 Enter "\\(name of server connected to 
machine)\(name of shared printer)", and click 
the "OK" button.

6 Click the "OK" button in the printer properties 
window.

name of server connected to machine

name of shared printer
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Scanning Overview
The flow chart shown below provides an overview of scanning.

*1 TWAIN is an international interface standard for scanners and other image acquisition devices. By installing a TWAIN driver on your computer, you can 
scan and work with images using a variety of TWAIN-compliant applications.

*2 WIA (Windows Imaging Acquisition) is a Windows function that allows a scanner, digital camera or other imaging device to communicate with an image 
processing application. The WIA driver for this machine can only be used in Windows XP.

*3 To scan using the machine's operation panel, you must first install Button Manager and establish the appropriate settings in the Control Panel. For 
details, see "SETTING UP BUTTON MANAGER" in the Software Setup Guide.

The environment in which the machine's scanning function can be used is subject to certain limitations. For details, see "BEFORE 
INSTALLATION" in the Software Setup Guide.

Caution

Scanning from a TWAIN*1-compliant 
or WIA*2-compliant application

Scanning from the "Scanner and 
Camera Wizard" (Windows XP) Using the machine to begin scanning*3

Place the original in the scanning position
☞For more information, refer to "NORMAL COPYING" in the Operation Manual.

Start up a Twain-compliant or 
WIA-compliant application, and 
select the machine's scanner 

Start up the "Scanner and 
Camera Wizard" from "Control 
Panel" in your computer.

Change the machine to scanner 
mode and press a scan menu key 
(1 to 6).

Set the scan preferences
(only if the preferences are set to appear)Set the scan preferences

Scanning
☞Scanning from a 

TWAIN-Compliant Application, 
Scanning from a WIA-Compliant 
Application (Windows XP)

Scanning
☞Scanning from the "Scanner and 

Camera Wizard" (Windows XP)

Scanning
☞"USING THE SCANNER MODE" 

in the Operation Manual,
Outline of Button Manager
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Scanning from a TWAIN-Compliant Application (part 1)
The SHARP scanner driver is compatible with the TWAIN standard, allowing it to be used with a variety of TWAIN-compliant 
applications. Below is a step-by-step guide for acquiring a scanned image to the Sharpdesk desktop screen using Sharpdesk.

1 Place the original(s) you wish to scan on the 
document glass/SPF.
�For information on setting an original for scanning, 

refer to "NORMAL COPYING" in the Operation 
Manual.

2 Start Sharpdesk and then click the "File" menu 
and select "Select Scanner".

3 Select "SHARP MFP TWAIN D", and click the 
"Select" button.

The method for accessing "Select Scanner" depends 
upon the application. For more information, refer to the 
manual or the help file of your application.

Note

If you are using Windows XP, you can also select 
"WIA-SHARP AL-XXXX" to scan using the WIA driver.
�Scanning from a WIA-Compliant Application 

(Windows XP)

Note
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Scanning from a TWAIN-Compliant Application (part 2)

4 Select "Acquire Image" from the "File" menu, or 
click the "Acquire" button ( ).
The scanner driver setup screen will appear.
�Scanner Driver Settings

5 In the "Scanning Source" menu, select the 
location where you placed the original in Step 1.
If you placed a one-sided original in the SPF, select 
"SPF (Simplex)".

6 Click the "Preview" button.
The preview image will appear.

� If the angle of the image is not correct, reset the 
original, and click the "Preview" button again.

� If the preview image is not oriented correctly, click the 
"Rotate" button in the preview screen. This rotates the 
preview image 90 degrees clockwise, allowing you to 
correct the orientation without resetting the original.
�Preview screen

� If you set multiple pages in the SPF, the machine 
previews only the top page of the originals, and then 
sends it to the original exit area. Return the previewed 
original to the SPF before starting the scanning job.

Note
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Scanning from a TWAIN-Compliant Application (part 3)

7 Specify the scanning area and set the scan 
preferences.
For information on specifying the scan area and setting 
the scan preferences, see scanner driver Help.
�Scanner Driver Settings

8 When you are ready to begin scanning, click the 
"Scanning" button.
To cancel a scanning job after clicking the "Scanning" 
button, press the [Esc] key on your keyboard.

When you close the scanner driver after scanning, the 
image data will appear as a new file in Sharpdesk, as 
shown below.

� Scanning a large area in full colour at high resolution 
results in a large quantity of data and a prolonged 
scanning time. It is recommended that you set the 
scanning preferences according to the type of the 
original being scanned, i.e., Monitor, Photo, FAX, or 
OCR.

� The scan resolution will vary depending on the 
scanning area and colour mode (Full colour, 
Greyscale, or Black & White). For example, if an A4 
original is scanned in full colour at 300 dpi, the 
machine will scan the original in full colour at 150 dpi 
and the scanner driver will enhance the resolution to 
300 dpi.

Caution



3 SCAN

23CONTENTS I N D E X

Scanning from a TWAIN-Compliant Application (part 4)

Scanner Driver Settings
The scanner driver setup screen consists of the "Set-up screen", which lets you select scan settings, and the "Preview screen", 
which shows the scanned image. For details on the scan settings, click the "Help" button in the preview screen to display Help.

Set-up screen "Scanning Source" menu
Select the location where the original 
is placed. Selections are "Platen" 
(document glass) or "SPF (Simplex)".
�Scanning from a TWAIN-Compliant 

Application

"Scanning Mode" menu
Select "Standard" or "Professional" for 
the scanning mode. For details on the 
settings, click the "Help" button in the 
preview screen to display Help.
"Zoom Preview" Checkbox
When this is selected, the selected part 
of the preview image will be enlarged 
when the "Preview" button is clicked.
To return to the regular view, remove 
the checkmark.

"Preview" button
Previews the document.

"Scanning" button
Click to scan an original using the 
selected settings. Before clicking the 
"Scanning" button, make sure the 
settings are correct.

"Close" button
Click to close the scanner driver setup 
screen.

1

2

3

4

5

6

On machines without an SPF, 
this setting is fixed at "Platen".

"Zoom Preview" cannot be used 
when "SPF (Simplex)" is selected 
in the "Scanning Source" menu.

1

Note

2

3

Note

If "Preview" is cancelled by 
immediately pressing the [Esc] 
key on your keyboard, or the 
[CLEAR] key ( ) or [CLEAR 
ALL] key ( ) on the machine, 
nothing will appear in the 
preview screen.

To cancel a scanning job after 
clicking the "Scanning" button, 
press the [Esc] key on your 
keyboard, or the [CLEAR] key 
( ) or [CLEAR ALL] key ( ) on 
the machine.

4

Note

5

Note

6
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Scanning from a TWAIN-Compliant Application (part 5)
Preview screen

Preview window
Click the "Preview" button in the Set-up screen to display the 
scanned image. You can specify the scanning area by 
dragging the mouse inside the window. The inside of the 
frame that is created when you drag the mouse will be the 
scanning area. To cancel a specified scanning area and 
clear the frame, click anywhere outside the frame.

"Rotate" button
Click to rotate the preview image 90 degrees clockwise. This 
allows the orientation to be corrected without resetting the 
original. Upon scanning, the image file is created in the 
orientation shown in the preview window.
"Image Size" button
Click to open a dialog box that allows you to specify the 
scanning area by entering numbers. Pixels, mm, or inches 
can be selected for the units of the numbers. By initially 
specifying a scanning area, numbers can be entered to 
change that area relative to the top left corner as a fixed 
origin.
"Auto Scan Area Judgement" button
Click when the preview screen is displayed to automatically 
set the scanning area to the entire preview image.

Click the "Auto Scan Area Judgement" button 
to automatically set the scanning area to the 
entire preview image.
Preview image
Preview window

"Help" button
Click to display the help file for the scanner driver.

1

3

2

4

5

1

2

3

4

5
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Scanning from a WIA-Compliant Application (Windows XP) (part 1)
If you are using Windows XP, you can use the WIA driver to scan from Sharpdesk, Paint and other WIA-compliant applications. The 
procedure for scanning using Paint is explained in the following.

1 Place the original you wish to scan on the 
document glass/SPF.
☞For information on setting an original for scanning, 

refer to "NORMAL COPYING" in the Operation 
Manual.

2 Start Paint and then click the "File" menu and 
select "From Scanner or Camera".
The scan screen of the WIA driver will appear.

If you have WIA drivers for other devices installed in your 
computer, the "Select Device" screen will open. Select 
"SHARP AL-XXXX" and click the "OK" button.

Note



3 SCAN

26CONTENTS I N D E X

Scanning from a WIA-Compliant Application (Windows XP) (part 2)

3 Select the paper source and picture type, and 
click the "Preview" button.
The preview image will appear.
If you placed the original on the document glass, select 
"Flatbed" for the "Paper source".
If you placed the original in the SPF, select "Document 
Feeder" for the "Paper source" and specify the original 
size in "Page size".

4 Click the "Scan" button.
Scanning begins and the image is acquired into Paint.
Use "Save" in your application to select a file name and 
folder for the scanned image, and save the image.
To cancel a scanning job after clicking the "Scan" 
button, click the "Cancel" button.

● If an SPF is not installed on your machine, the "Paper 
source" menu will not appear.

● If you select "Document Feeder" for the "Paper source" 
and click the "Preview" button, the top original in the 
SPF is previewed. The previewed original is sent to the 
original exit area, so you will need to return it to the 
SPF before starting the scanning job.

● To view Help for a setting, click the  button in the 
upper right-hand corner of the window and then click 
the setting.

Note
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Scanning from the "Scanner and Camera Wizard" (Windows XP) (part 1)
The procedure for scanning with the "Scanner and Camera Wizard" in Windows XP is explained here. The "Scanner and Camera 
Wizard" lets you scan an image without using a WIA-compliant application.

1 Place the original you wish to scan on the 
document glass/SPF.
☞For information on setting an original for scanning, 

refer to "NORMAL COPYING" in the Operation 
Manual.

2 Click the "start" button, click "Control Panel", 
click "Printers and Other Hardware", and then 
click "Scanners and Cameras".

3 Click the "SHARP AL-XXXX" icon and then click 
"Get pictures" in "Imaging Tasks".
The "Scanner and Camera Wizard" will appear.

4 Click the "Next" button.
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Scanning from the "Scanner and Camera Wizard" (Windows XP) (part 2)

5 Select the "Picture type" and "Paper source", 
and click the "Next" button.
If you placed the original on the document glass, select 
"Flatbed" for the "Paper source".
If you placed the original in the SPF, select "Document 
Feeder" for the "Paper source" and specify the original 
size in "Page size".
You can click the "Preview" button to display the 
preview image.

6 Specify a group name, format and folder for saving 
the image, and then click the "Next" button.
JPG, BMP, TIF or PNG can be selected for the format. 
To begin scanning, click the "Next" button.

● If an SPF is not installed on your machine, the "Paper 
source" menu will not appear.

● If you select "Document Feeder" for the "Paper source" 
and click the "Preview" button, the top original in the 
SPF is previewed. The previewed original is sent to the 
original exit area, so you will need to return it to the 
SPF before starting the scanning job.

● To adjust the resolution, picture type, brightness and 
contrast settings, click the "Custom settings" button.

Note
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Scanning from the "Scanner and Camera Wizard" (Windows XP) (part 3)

7 When scanning ends, the following screen will 
appear. Select the next task you wish to 
perform, and then click the "Next" button.
If you are ready to end the session, click "Nothing. I'm 
finished working with these pictures".

8 Click the "Finish" button.
The "Scanner and Camera Wizard" closes and the 
scanned image is saved in the specified folder.
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Outline of Button Manager
Button Manager is a software utility that links scanning functions to the scanner key on the machine. The Button Manager software 
allows you to assign scan settings to each of the six scan menu keys on the machine.
To view Help for a setting, click the  button in the upper right-hand corner of the window and then click the setting.
�To begin scanning using the machine's operation panel, settings must be established in the Control Panel after Button Manager is 

installed. For information on installing Button Manager and establishing the Control Panel settings, see "SETTING UP BUTTON 
MANAGER" in the Software Setup Guide. For information on scanning using the machine's operation panel, see "USING THE 
SCANNER MODE" in the Operation Manual.

Tab
Click to set scan menu 
options. Each tab contains 
scan settings for the scan 
menu keys (SC1 through 
SC6) on the machine.
"Application Selection" area
Select the start-up 
application here.
"Show TWAIN setting 
screen when scanning"
Checkbox
You can select whether or not 
the TWAIN screen is shown. 
When the checkbox is 
selected, the TWAIN screen 
appears when scanning is 
executed to let you adjust the 
scanning conditions.

"Scan Setup" area
Set the scan conditions.

"OK" button
Click to save your settings 
and exit the dialog box.
"Cancel" button
Click this button to exit the 
dialog box without making 
any changes to the settings.
"Apply" button
Click to save your settings 
without closing the dialog box.
"Help" button
Click this button to display the 
help file for Button Manager.

You can use Button Manager to select and change the functions of the six scan menus. Refer to Button Manager Settings.

1

3

2

4

5

6

8

7

1

2

3

� Some applications 
may limit your 
choice of settings.

� When "Show TWAIN 
setting screen when 
scanning" is selected, 
the scan conditions 
cannot be selected.

4

Note

5

6

7

8



3 SCAN

31CONTENTS I N D E X

Button Manager Settings
Once installed, Button Manager normally runs in the background in the Windows operating system. If you need to change Button 
Manager settings, follow the steps below.
For details on Button Manager settings, see Button Manager Help.
�Outline of Button Manager

1 Right-click the Button Manager icon ( ) on the 
task bar, and select "Settings" from the pop-up 
menu.
The setting screen of Button Manager will open.

2 Click the tab of the scan menu you want to set 
up.

3 Set up the start-up application in the 
"Application Selection" area.

4 Set up the "Colour Mode", "Edge" and other 
scan settings in the "Scan Setup" area.

5 Click the "OK" button.
This completes the settings.

If the Button Manager icon does not appear on the task 
bar, click the "start" button, select "All Programs" 
("Programs" in Windows 98/Me/2000), select "Sharp 
Button Manager D", and then click "Button Manager" to 
start Button Manager.

Note

When the "Show TWAIN setting screen when scanning" 
checkbox is selected, the scan setting screen appears 
when scanning is executed to let you adjust the 
scanning conditions.

Note
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Index
For detailed information on the settings in the printer driver, Print Status Window, scanner driver, and Button Manager, see the help 
files for each.

A
Application Selection...........30
"Auto Scan Area Judgement" button ..24

B
Basic Printing ........................5
Border ...................................9
Button Manager ..................30
Button Manager Settings ....31
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Print ...................................... 5
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